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ELECTRONIC AUCTION RESOURCES

HOW TO MONITOR THE FCC AUCTIONS ON-LINE

The auction announcements and round results for Auction 20 will be accessible through the
FCC Wide Area Network, the Internet and the FCC Auctior. Bulletin Board System (BBS).
You can check on round results and also read any material released by the Commission

during the course of the auction. This fact sheet provides the information that you need to

track the auction from your computer.

Option 1: Tracking the Auction via the FCC Wide Area Network

The FCC has implemented a Remote Access System that allows users to dial in directly to
the FCC to view round results, auction announcements, and messages, and to make
suggestions to the FCC regarding the FCC auction process.

The following minimum hardware and software is required to use the FCC Remote Access
System:

Minimum Hardware Requirements

CPU: Intel Pentium

RAM: 16 MB (more recommended if you have multiple applications open)
Modem: v.32bis 14.4kbps Hayes compatible modem or faster

Monitor: VGA or above

Mouse or other pointing device

© O O O O

Minimum Software Requirements

0 Operating System: Microsoft Windows 95/98 [Note: The FCC no longer supports
Windows 3.1x]

0 Point-to-Point Protocol (PPP) Dialer: Use the Dial-Up Networking feature
included with Windows 95/98

0 Web Browser: Netscape Communicator 4.05 with JDK 1.1 or a higher version
of Netscape (available at http://www.netscape.com)
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Connecting to the FCC Network

To use the FCC Remote Access System, you must first connect to the FCC Network using
Dial-Up Networking.

Dial-Up Networking connects to a 900 number telephone service at a charge of $2.30 per
minute. The first minute of connection time to the 900 number service is at no charge.

Dial-Up Networking establishes a point-to-point connection from your PC to the FCC
Network. This point-to-point connection is not routed through the Internet.

For instructions regarding how to connect to the FCC Network using Dial-Up Networking,
see the Accessing the FCC Network Using Windows 95/98 section.

Note: Throughout these instructions, “enter” means to type the appropriate information and
then press the ENTER key.
Using the FCC Remote Access System

After you have connected to the FCC Network, start your Netscape Web browser. In your
browser’s Location field, enter the following location:

. http://wtbwww03.fcc.gov and then click Round Results Viewer, Suggestion
Box, or Announcements

When you have finished, exit your Web browser, then disconnect from the FCC Network.

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The FCC Technical
Support Hotline is generally available Monday through Friday, from 8 am. to 6 p.m. ET. 4i]
calls to the FCC Technical Support Hotline are recorded.

Option 2: Tracking the Auction via the Internet

You may use your Web browser to download announcements and round results from
webwwwOl.fec.gov or www.fec.gov as described in the following section.

Downloading from wtbwww0l.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field of the Web browser screen, enter the following location:
http://wtbwww0l.fcc.gov
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3. a. Click on Auction 20.
b. For auction announcements, click on Announcements.
For auction round results, click on Results.

4. Click on the file you wish to download.

Downloading from www.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.
2. In the Location field of the Web browser screen, enter the following location:
http://www.fcc.gov
3. a. Click on Auctions. :
b. In the Auctions section on the right, click on Public Coast Stations under /n
Progress.

c. Click on Data(Round Results), Announcements, Template.
d. For auction announcements, click on Announcements.
For auction round results, click on Public Coast Stations Auction Round

Results.
To download a bid import template file, click Template.

4, Click on the file you wish to download.

Archive Directories

The FCC will establish archive directories for round results files on the Internet. After every
50 rounds, files will be moved from the Results directory to an archive directory. The newest
round results files will continue to be uploaded to the Results directory.

For example, in round 102, round results files would be located as follows:

On wtbwww0l.fcc.gov:

Rounds 1-50 pub/VPC/Auction_20/Results/R001-050
Rounds 51-100 pub/VPC/Auction_20/Results/R051-100
Rounds 101-102 pub/VPC/Auction_20/Results

On www,fcc.gov:
Rounds 1-50 pub/Auctions/VPC/Auction_20/Results/R001-050

Rounds 51-100 pub/Auctions/VPC/Auction_20/Results/R051-100
Rounds 101-102 pub/Auctions/VPC/Auction_20/Results
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Option 3: Tracking the Auction via the Bulletin Board System (BBS)

The FCC Auction Bulletin Board System (BBS) provides dial-in access for Auction Results.
To access the FCC Auction BBS, use a communications package that can handle Zmodem
protocol (such as PcAnyWhere, Procomm, or Microsoft Hyperterminal in Windows 95/98) to
dial in to (202) 682-5851. Use the settings of 8 data bits, no parity and 1 stop bit (8,N,1).

Once your computer is connected to the Auction BBS, do the following:

1. To create an account:
a. Enter your first name.
b. Enter your last name.
c. When asked whether you want to create an account, enter y. (You may also
enter ¥, the program accepts either case.)
d. When prompted, enter a password.
The password can be from four to ten characters long (where the characters can
be either letters or numbers).
e. To confirm the password, enter it again.
f. When prompted for contact information, enter your voice phone number.
Include the area code; for example, you might enter 202-555-1234.
g. Enter your company name.
2. On the Welcome screen, enter ¢ for Continue.

(')

When asked whether you want to view the bulletin menu, enter y for Yes. Then, to

continue, press ENTER to obtain the FCC Auction BBS Main Menu.

4, Enter a (for Auction Menu) to obtain the Auction Library Menu. The top options on
this menu provide a range of numbers to represent the available auctions.

5. To select Auction 20, enter b to select the second range.
6. On the Auctions Library Menu, enter the number of the auction you want. Enter 0, in
this case.

The Auction Menu appears.
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10.

Enter a to select Announcements or enter r to select Results.

The list of available files for Auction 20 appears. These files are sorted by date, with
the most recent files at the beginning of the list.

To scroll downward to the next screen of file names, either press ENTER or enter ¢ for
Continue. To scroll upward to the preceding screen of file names, enter p for

Previous.

Note that on each screen, file names are numbered separately, starting with 1.

To select one or more files for downloading or viewing, mark the files you want. The
program marks a file by preceding its name with an asterisk (*).

You can do the following:
o To mark an individual file, enter its line number.

o To mark a range of files, enter m (for Mark) and then enter the range of files in
response to the prompt. For example, to mark files 6 through 12, enter 6-12 at the

prompt.

o To unmark a file, enter its number again. You can also use Mark to unmark a
range of files.

When you have finished marking files, you may download or view the marked files
(you may only view text files).

To download the marked files, take the following steps:

a. Enter d for Download.

The program displays a list that summarizes the download operation. The Time
column lists the download time for each file; the Total Time column lists a
running total of the download times.

b. Enter d to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation
software (e.g., Zmodem).

d. When the download operation has finished, the list of files reappears.
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To view the marked files, do the following:
a. Enter v for View.
b. Enter the file number that you would like to view.

11, Enter x to leave the BBS.

Note: All round results files will be accessed through the Results menu on the BBS. No
archive menus will be created.

Announcement Files

The announcement files will use the following naming convention: aa_xxx.nn where aa is the
auction number, xxx is the round number and »nn is the announcement number. For example,
20_002.07 would represent an announcement for Auction 20 that was posted during round
two and was the seventh announcement for the auction.

Round Results Files

For each round, dBase-compatible database files will be uploaded with the following naming
conventions:

20_xxxS.DBF contains all bids submitted in a particular round

20 _xxxW.DBF contains all bids withdrawn in a particular round

20_xxxE.DBF contains the maximum eligibility and remaining number of waivers for
each bidder

20 xxxH.DBF contains the high bids in a particular round and the minimum accepted
bids for the next round

where xxx represents the round number.
For those who cannot use the dBase-compatible database files, we will also upload the ASCII

text (TXT) version of these files with the same filenames as above (e.g., 20_xxxS.TXT,
20_xxxE.TXT).

Round Results File Formats

The Round Results File Formats will be published in a future Public Notice.
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Help

For technical assistance with downloading files or installing and using FCC software, contact
the FCC Technical Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY). The
FCC Technical Support Hotline is generally available Monday through Friday, from 8 a.m. to
6 p.m. ET. All calls to the FCC T echnical Support Hotline are recorded.
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AUCTION TRACKING SOFTWARE

The Commission will provide, free of charge, a stand alone tracking tool to assist bidders and
non-bidders in tracking the auction. In the past, this tool has been provided in an Excel
spreadsheet format that required users to download round results files and import them into the
tracking tool software for processing. The Commission is investigating ways to make the
tracking tool software more efficient and effective, and hopes to have a revised tool in place
before the beginning of Auction 20. In the absence of a revised tracking tool, software
resembling that used in previous auctions will be provided. Details will be released as soon as

they are available.
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ACCESSING THE FCC NETWORK USING
WINDOWS 95/98

This describes how to access the FCC Network from a system that is running the Microsoft
Windows 95 or Microsoft Windows 98 operating system. This involves configuring dial-up
network access and then performing the dial-up procedure.

Conventions

The instructions in this section use the following typographical conventions:

bold

italic

bold italic

Represents objects on the screen that you click with the mouse pointer,
including buttons, Internet links, icons, tabs, menu items (e.g., Cancel button,
Auctions link, Save option in the File menu).

Represents field names or areas of a screen (e.g., 4pplicant field, Selected
Licenses area of a screen).

Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type
http://wtbwww03.fcc.gov, you should type all of the characters shown in bold
italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these instructions, “enter” means to type the appropriate information and
then press the ENTER key.

Configuring Dial-Up Networking

1. To start dial-up networking:

g0 op

Click the Windows 95/98 Start button.

Click the Programs option to display the Programs menu.

Click the Accessories option to display the Accessories menu.

In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install
it from your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon.
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The Make New Connection window appears.

If you are connecting to submit FCC Form 175 applications, type FCC Auctions
800# in the field titled Type a name for the computer you are dialing.

If you are connecting to review FCC Form 175 applications or to use the FCC Remote
Access System, type FCC Auctions 900# in the field titled Type a name for the

computer you are dialing.

Note: If you connect to the FCC’s 900# telephone service, there is a charge of
$2.30 per minute. The first minute of connection time to the 900 number
service is at no charge.

In Windows 95, click the down arrow at the right of the Select a modem field and
select your modem from the menu of available modems.

In Windows 98, click the down arrow at the right of the Select a device field and
select your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver
according to the modem manufacturer installation procedures, which are usually
described in your modem’s user manual.

Click the Next button.

If you are connecting to submit FCC Form 175 applications, type 800 and 378-7435 in
the Area Code and Telephone Number fields, respectively.

If you are connecting to review FCC Form 175 applications or to use the FCC Remote
Access System, type 900 and 555-5335 in the Area Code and Telephone Number
fields, respectively.

Verify that the correct country is selected in the Country code field.

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

Click the Next button.

Click the Finish button.

An icon labeled either FCC Auctions 800# or FCC Auctions 900# appears in the Dial-
Up Networking window.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Verify that properties are configured correctly before attempting a dial-up session. Put
the mouse pointer on the FCC Auctions icon that you wish to configure and click the
right mouse button to display a menu. Click Properties from the menu.

Click the Configure button. Click the Options tab at the top of the Properties
window.

In the Connection control area of the Options tab, verify that neither option is
selected. If either option is selected, click the check box at the left of the option to

deselect it. Then click OK.
In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

In the Advanced Options area, verify that only Enable software compression is

selected.
If it is not selected, click the check box at the left of the option to select it. If either

of the other options is selected, click the check box to deselect it.
In the Allowed Network Protocols area, verify that only TCP/IP is selected.

If it is not selected, click the check box at the left of the option to select it. If either
of the other options is selected, click the check box to deselect it.

Click the TCP/IP Settings button and select Specify name server addresses.

Type 165.135.22.249 as the Primary DNS.

Click OK on the TCP/IP Settings window and the Server Type window.

Dial-Up Procedure
If the Dial-Up Networking window is not currently open, do the following:

Click the Windows 95/98 Start button.

Click the Programs option to display the Programs menu.

Click the Accessories option to display the Accessories menu.

In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking.

o op

The Dial-Up Networking window appears.

In the Dial-Up Networking window, double-click the FCC Auctions 800# or FCC
Auctions 900# icon.
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Note: If you connect to the FCC’s 900 number telephone service, there is a charge of
$2.30 per minute. The first minute of connection time to the 900 number

service is at no charge.
3. Click the Connect button on the window. Do not enter User name and Password.

The Connection window appears, indicating the status of your connection as your
modem dials into the system. This window must remain running during your dial-up
session. You may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section

below.
4. Once the connection is established, open your Web browser.
5. In your browser’s Location field, enter the appropriate Universal Resource Locator

(URL) as follows:
J For FCC Form 175 Submit, enter http:/wtbwww04.fcc.gov

. For FCC Form 175 Review or the FCC Remote Access System, enter
http://wtbwww03.fcc.gov

If nothing appears in your Web browser, please see the Troubleshooting section below.
6. When you have finished, exit the Web browser, then click the Disconnect button on
the Connection window to end your dial-up session.
Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

Modem does not respond

1. Confirm that all physical connections for the modem are present.
2. Confirm that the phone line is active by connecting it to a telephone and checking for
a dial-tone.

If you are dialing the 900 number service, check for a 900 number telephone block. If
the volume settings are low, the modem may be dialing but not connecting. Check for
this by trying to connect to the 800 number, or by dialing the 900 number on that line
using a telephone.

(98}

134



4,

Confirm that the correct modem driver is installed for your modem.

Modem dials but does not connect

1.

If you are dialing the 900 number service, check for a 900 number telephone block.
Check for this by dialing the 800 number to see if you connect, or by dialing the 900

number on that line using a telephone.

Confirm that the number the modem is dialing is correct.

Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the Location in the Web
browser

1.

(U8

If your Internet Service Provider adds numbers to the DNS Server Search Order list in
your Dial-Up Adapter’s TCP/IP protocol, you will need to add the FCC’s Primary
DNS number as well. Do the following:

a. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties. If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

d. Click the DNS Configuration tab.

e. Ensure Enable DNS is selected and type 165.135.22.249 in the DNS Server Search
Order box, then click the 4dd button.

£ Click OK on the TCP/IP Properties windows, then click OK on the Network
windows.

g. If you are prompted to restart your computer, click Yes to restart, then reconnect to
the FCC Network.

Verify the properties in your dial-up networking icon, particularly that the Primary
DNS is set to 165.135.22.249 and that TCP/IP is the only selected protocol.

Confirm that your Web browser is not using proxies.
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Receive an Internal Server error in the Web browser
1. Confirm that the Location is correct.

2. Confirm that JavaScript is enabled in your Web browser.

Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (voice) or (202) 414-1255 (text telephone (TTY)). The
FCC Technical Support Hotline is generally available Monday through Friday, from 8 a.m. to
6 p.m. ET. All calls to the FCC Technical Support Hotline are recorded.
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